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Operating Instructions
Before operating this printer, please read this
manual thoroughly and retain it for future
reference.

Mode d’emploi
Avant d’utiliser cette imprimante, veuillez lire
attentivement ce manuel et le conserver pour toute
référence ultérieure.

Manual de instrucciones
Antes de utilizar esta impresora, lea este manual
atentamente y consérvelo para consultarlo en el
futuro.
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WARNING

To prevent fire or shock hazard, do
not expose the unit to rain or
moisture.

To avoid electrical shock, do not
open the cabinet. Refer servicing to
qualified personnel only.

ATTENTION
Pictures and/or Sound distortion may occur if
this product is positioned in close proximity to
equipment emitting electromagnetic radiation.

Attention
Sony shall assume no responsibility for any
accidental or consequential damages or loss
of the recording contents which may be
caused by use or malfunction of the printer,
“Memory Stick” or PC card.

For the customers in the U.S.A.

WARNING
This equipment has been tested and found to
comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses, and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur in a
particular installation. If this equipment does
cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the user
is encouraged to try to correct the interference
by one or more of the following measures:

– Reorient or relocate the receiving antenna.
– Increase the separation between the

equipment and receiver.
– Connect the equipment into an outlet on a

circuit different from that to which the
receiver is connected.

– Consult the dealer or an experienced radio/
TV technician for help.

Owner’s Record
The model and serial numbers are located
on the bottom.  Record the serial number
in the space provided below.  Refer to this
number whenever you call upon your
Sony dealer regarding this product.
Model No.  DPP-SV77
Serial No.

If you have any questions about this product, you
may call:
Sony’s Business Information Center (BIC) at 1-
800-686-SONY (7669)
or Write to: Sony Customer Information Services
Center
6900-29 Daniels Parkway, PMB 330
Fort Myerts, Florida 33912

  Declaration of Conformity

Trade Name: SONY
Model No.: DPP-SV77
Responsible Party:

Sony Electronics Inc.
Address: 1 Sony Drive, Park Ridge,

NJ   07656  U.S.A.
Telephone No.:   201-930-6972
This device complies with part 15 of the
FCC Rules. Operation is subject to the
following two conditions:
(1) this device may not cause harmful
interference, and (2) this device must
accept any interference received,
including interference that may cause
undesired operation.
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Notice for users

Program © 2001 Sony Corporation
Documentation ©2001 Sony Corporation

All rights reserved. This manual or the software
described herein, in whole or in part, may not
be reproduced, translated or reduced to any
machine readable form without prior written
approval from Sony Corporation.

IN NO EVENT SHALL SONY CORPORATION
BE LIABLE FOR ANY INCIDENTAL,
CONSEQUENTIAL OR SPECIAL DAMAGES,
WHETHER BASED ON TORT, CONTACT, OR
OTHERWISE, ARISING OUT OF OR IN
CONNECTION WITH THIS MANUAL, THE
SOFTWARE OR OTHER INFORMATION
CONTAINED HEREIN OR THE USE THEREOF.

By breaking the seal of the envelope of the CD-
ROM package, you accept all the terms and
conditions of this agreement. If you do not
accept these terms and conditions, please
return this disk envelope unopened, along with
the rest of the package, immediately to the
dealer where you obtained it.

Sony Corporation reserves the right to make
any modification to this manual or the
information contained herein at any time
without notice.
The software described herein may also be
governed by the terms of a separate user license
agreement.

User Registration
To receive customer services, complete and
return the registration card included in your
package.
Any design data such as sample pictures
provided in this software cannot be modified or
duplicated except for the purpose of personal
use. Any unauthorized duplication of this
software is prohibited under copyright law.
Please note that unauthorized duplication or
modification of others’ portraits or copyrighted
work could infringe the rights reserved by right
holders.

•Microsoft, MS, MS-DOS and Windows®

are registered trademarks of Microsoft
Corporation in the United States and
other countries.

•IBM and PC/AT are registered
trademarks of International Business
Machines Corporation.

•MMX and Pentium are registered
trademarks of Intel Corporation.

•Apple, Macintosh, Power Macintosh,
and Mac OS are registered trademarks of
Apple Computer, Inc.

• “Memory Stick,” “MagicGate Memory
Stick” and their logo marks are the
trademarks of Sony Corporation.

•All other companies and product names
mentioned herein may be the
trademarks or registered trademarks of
their respective companies. Furthermore,
“™” and “®” are not mentioned in each
case in this manual.

You are cautioned that any changes or
modifications not expressly approved in this
manual could void your authority to operate
this equipment.

The shielded interface cable recommended in
this manual must be used with this
equipment in order to comply with the limits
for a digital device pursuant to Subpart B of
Part 15 of FCC Rules.

CAUTION
To prevent electric shock, match wide blade
of plug to wide slot, fully insert.

CAUTION
The nameplate is located on the bottom
enclosure.

GB
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Getting started

What you can do with the printer

With the Digital Photo Printer DPP-SV77,  you can print images stored on a
“Memory Stick” or PC card.  You can also print easily from your computer.

Photo-realistic printing
With its sublimation dye transfer printing system, the printer can make
photo-realistic prints meeting a number of different requirements.

Super Coat 2 feature
The Super Coat 2 enables high durability and moisture or fingerprint
resistance, keeping your prints in good picture quality for an extended
period of time.

Easy stylus operations on the color LCD screen
With the color touch-sensitive LCD screen, you can easily perform the
operations with the touch of a stylus and preview the images to be printed.
To select an image or an item, just tap the screen lightly with the stylus
supplied with your printer.  A series of screen-activated operations will
navigate you though the printing process.
To view the images on a wider screen, you can also connect your printer to
your television.

Auto Fine Print 2 function
Even a dark picture with low contrast can be adjusted and printed as a vivid
and clear picture.

Selection of print sizes and border/borderless print formats
You can select from a large, dynamic Post Card size print or an economical
Small size print.  For the Post Card size print, you can also select a borderless
or border print format.

Direct printing of “Memory Stick” or PC card images
Just take a “Memory Stick” or PC card from your digital still camera and
insert it into the printer.  You can immediately print any of the images in the
“Memory Stick” or PC card.  You can also print all the images in a “Memory
Stick” or PC card or the images preset by a digital still camera at one time.

Selection of print finish
You can select the print finish from either glossy or texture.

Continued
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What you can do with the printer

Printing 25/30 sheets at one time
With the supplied paper tray, you can print up to 25 sheets for Post Card size
and 30 sheets for Small size print paper at one time.

A wide variety of prints available with your printer
You can make various types prints such as a standard print, a date print, or
an index print of the images stored in a “Memory Stick” or PC card.  A
variety of image processing functions allow you to magnify/reduce, rotate,
flip, or move the image.  You can also add a special effect to the picture to
produce sepia, monochrome, or paint pictures, or use tools to paint freehand
drawings, add stamps, or input characters on an image.

An even wider variety of prints using the Creative Print menu
The Creative Print menu allows you to make even more types of prints such
as a calendar, a card, split images, a sticker with framed images.

Making a convenient USB connection with your computer
By installing the supplied DPP-SV77 printer driver software on your
computer, you can print images from your computer.  With the supplied
“Memory Stick/PC card Reader Software,” you can view and handle the
images in a “Memory Stick” or PC card inserted in the printer from your
computer.

On the demonstration mode
You can view the demonstration of the DPP-SV77 features.
Turn on the power of the printer while the “Memory Stick” or PC card is not
inserted.  The demonstration button is displayed in the lower-right on the
screen.  Tap the button to start the demonstrations.  The DPP-SV77 features
will be shown in order.  To stop the demonstrations, tap anywhere on the
screen.
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Unpacking the printer

Make sure that the following accessories are supplied with your printer.

• AC power cord (1)*

• Video connection cable (1)

• Paper tray (1)

• Stylus (1)

• CD-ROM (1)

–Sony DPP-SV77 Printer Driver
Software for Windows 98/
98SE/Me/2000 Professional
Ver. 1.0

– Sony DPP-SV77 Printer Driver
for Mac OS 8.5.1, 8.6, 9.0/9.1
Ver. 1.0

– Memory Stick/PC card Reader
Software for Windows  98/
98SE/Me/2000 Professional
Ver. 1.0

• Clamp filter (1)

• Operating Instructions (1)
• Warranty (1)
• Sample Printing Pack (1)
• Owner registration card (1)
• Sony End User Software License Agreement (1)

*Note

The AC power cord illustrated is for 120V only.  The plug shape and specifications
change depending on the region you use the printer.
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For details, see the pages indicated in
the parentheses.

Printer front panel
1 Operation panel (next page)

Push PUSH/OPEN to open the operation
panel (page 11).

2 POWER button (pages 19, 23)
Lights in orange in the standby mode
and lights in green in the power-on
mode.

3 “MEMORY STICK” insertion slot
(page 14)

4 PC CARD insertion slot (page 14)
5 PC card eject button (page 14)
6 Paper tray compartment lid

Insert the supplied paper tray here.

7 Cartridge compartment lid (page
19)

8 Print cartridge eject lever (page
20)
Push up to eject the print cartridge.

9 Print cartridge  (pages 18, 19)
(Not supplied)

Printer rear panel
1 USB connector (page 16)

Connects to the USB connector of your
computer.

2 VIDEO OUT connector (page 15)
Connects to the VIDEO input of your
television.

3 AC IN connector (page 16)
4 Ventilation holes

Identifying the parts
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Printer operation panel 
The buttons on the LCD touch-sensitive
operation panel (1 through 9) are
designated with square brackets in this
manual (ex. [PICTURE]).

1 PICTURE button (page 24)
Switches the thumbnail list and preview
image.

2 INPUT SELECT button  (page 23)
Switches the input.  (The selected input
indicator qv  lights.)

3 LCD screen (next page)
Displays the images, menu items, or
available options.

4 PRINT QUANTITY (+/–) buttons
(page 25)
Specifies the print quantity.

5 Arrow (B/b/V/v) buttons (page
13)
Moves the cursor to an image or item on
the LCD screen 3.

6 MENU button (pages 59)
Displays the Menu screen.

7 EFFECT button (page 29)
Displays the Effect menu.

8 CREATIVE PRINT button (page 45)
Displays the Creative Print menu.

9 ENTER button (page 13)
Selects the image(s) or item(s) indicated
using the cursor on the screen.

0 ALL button (page 28)
Selects automatic printing of all images.

qa DPOF button (page 28)
Selects automatic printing of all DPOF
images.

qs Stylus (page 12)
Used to select an item on the screen.
Place the stylus in the slot to prevent it
from being lost.

qd PRINT button (pages 26, 28)
qf “MEMORY STICK”/PC CARD/PC

input indicators  (pages 17, 23)
The indicator for the current input signal
lights.

qg Paper error indicator (pages 22,
88)

qh Cartridge error indicator (page
20)
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Thumbnail list

Paper tray
1 lid

2 Partition

Screen
1 Print quantity indication

Indicates the print quantity. (In preview,
no indication appears when the quantity
is set to zero.)

2 Image number
3 “Memory Stick”/PC Card indication

Indicates that the type of media currently
being used.

4 Cursor (yellow frame)
Indicates that the image with the cursor.

5 Selection (orange)
Indicates that the image has been selected.

6 The quantity of selected images/
the total image quantity
When no image is selected, only the total
image quantity is displayed.

7 Print cartridge indication
Indicates the type of print cartridge
currently loaded (P: Post Card size/S:
Small size).

8 Scroll bar
Indicates the position of the image
currently displayed or selected from
among the total number of images.

9 Print preset (DPOF) indication
Indicates the image is DPOF preset for
printing from a digital still camera.

0 Guidance message
Displays simplified instructions for the
next step.

qa Protect indication
Indicates the image is protected by a
digital still camera.

Identifying the parts
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Continued

Using the stylus and operation panel

Most operations on the DPP-SV77 are carried out by tapping an item or
button on the touchscreen of the operation panel.  This section explains how
to use the stylus and touchscreen.

Note on the LCD screen

The LCD is manufactured using high-precision technology. You may, however, see
brighter points or color shifts on the LCD depending on the viewing angle. This is a
normal result of the manufacturing process and does not indicate a malfunction.

Opening the operation panel

Open the operation panel while pressing PUSH/OPEN.

      PUSH/OPEN

You can rotate the operation panel up to 180
degrees.  Use the panel at an appropriate
angle such that you can view the screen
clearly and can perform the stylus operations
easily.

After you finish

•To keep the touchscreen safe and clean, we recommend you close the operation
panel after you finish using your printer.

•Keep the stylus in the slot on the panel to prevent it from being lost.
•If the screen becomes soiled, wipe it with a soft dry cloth such as a cloth used to

clean your eyeglasses.
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Using the stylus

Press lightly on the button, image or item on the operation panel
screen using the point of the supplied stylus.
This action is referred to as “tapping” in this manual.  Tapping allows you to
execute the button function or select an item or image on the screen.

After you finish

Keep the stylus in the slot on the panel to prevent it from being lost.

Notes

•Always use the point of the supplied stylus for tapping the screen. Never use a real
pen, pencil, or other sharp object to write on the screen.

•In case you lost the supplied stylus, you can use Sony optional accessory.

Using the stylus and operation panel
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Selecting an image or item on the screen
You can select an item on the screen using either of the following methods

   Operation panel

              Screen

  x Tap directly on the image or item on the screen.
The image or item is immediately selected.  In this manual, this direct-
tapping method is the primary method used to explain the procedures.

  x Tap the arrows [B/b/V/v] to move the yellow frame (cursor)
to an item or image on the screen and then tap [ENTER].
The item or image is selected after you tap [ENTER].

Note

In some steps or operations, the following restrictions apply in selecting an item or
image.  Follow the guidance message displayed on the screen:

•You can use only arrow [B/b/V/v] or direct tapping to select an item.
•You can use only the vertical arrow [V/v] or horizontal arrow [B/b]  buttons.
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1 Connecting the printer

Inserting a “Memory Stick” or PC card

Notes

•Do not attempt to force a “Memory Stick” or a PC card into or out of the slot.  If
you do, the “Memory Stick” or the PC card or the printer may be damaged.

•When the printer is accessing the “Memory Stick” or PC card and the relevant
indicator flashes, do not remove the “Memory Stick” or PC card from the printer.  If
you do, the “Memory Stick” or the PC card or the printer may be damaged.

Printing an image from a “Memory Stick”
Insert the “Memory Stick” into the “MEMORY STICK” insertion slot until it
clicks into place.

 “Memory Stick”

With the notch facing left and the arrow facing
forward on the left

To eject the “Memory Stick”
Push the “Memory Stick” further into the insertion slot and let it pop out.
Then remove it slowly.

Note

Insert the “Memory Stick” only.  Do not insert any other objects.

Printing an image from a PC card
Insert the PC card into the PC CARD insertion slot until it clicks into place.

PC CARD eject button

PC card

To eject the PC card
Press the PC CARD eject button.  After it pops out, remove it slowly.

Setting up
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Note

Insert the PC card only.  Do not insert any other objects.

Connecting to a television (optional)

You can use the color LCD screen of the printer to select items or view the
images to be printed.  To display images or items on a wider screen, you can
also connect the VIDEO OUT connector of the printer to the video input of a
television.

Television
Set the VIDEO/
TV input
selector to
VIDEO.

Video connecting cable (supplied)

Notes

•The video output to a television is factory-set to Off.  To display the image on your
TV screen, set it to On on the MENU screen.

•Depending on the screen, the display output differs between the television and
printer screen.

•Before making connections or plugging in a cable, turn off the power of the printer
and the television.

•When using a commercially available video cable, use a cable 3 m or shorter in
length.

•When you connect your printer to a personal computer, you do not need to connect
your printer to a television.

• You cannot tap to operate on the TV screen.

Continued
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1 Connecting the printer

To the wall
outlet

AC power cord
(supplied)

Windows/Macintosh
computer*

To USB connector
To USB connector

Connecting the AC power cord

After you make the connections, connect the supplied AC power cord to the
AC IN connector of the printer and then to an AC outlet.
The POWER indicator lights in red.

Connecting to a computer (optional)

Connect the USB connectors of the printer and your computer (Windows PC
or Macintosh) with a commercially available USB cable.  By installing the
supplied driver software on your computer, you can print an image from your
computer’s hard disk.   With the “Memory Stick/PC Card Reader Software,”
you can also transfer images from a “Memory Stick” or PC card to your
computer’s hard disk.
For details on how to install and operate the software, see “Printing from your
computer” (pages 67–81).

*Note

The Reader software supports Windows only.
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When you connect a computer that is already powered on to the
USB connector of the printer

The PC input indicator lights and the printer enters the PC mode.

Notes

•Use a USB cable 3 m or shorter in length.
•Without connecting a computer that is already powered on to the USB connector,

you cannot switch to the PC mode manually by touching [INPUT SELECT].
•When you connect your printer to a television, no pictures are displayed on the

television in the PC mode.  This is not due to trouble with the printer.
•Refer to the instruction manual of your computer for further information.
•You cannot use the printer and the printer driver on a network or with a

commercially available printer buffer.

Note on using a USB cable

If your USB cable is not equipped with a clamp filter, attach the supplied clamp filter
near the printer’s USB connector of the cable .

To attach the clam filter,  release the lock of the clamp filter with a screwdriver or a
similar tool, contain the cable, and lock the filter in place as illustrated below.  Please
attach the filter as nearest the printer’s USB connector as possible.

MEMORY
STICK

PC
CARD PC
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2 Preparing the printing pack

You need an optional printing pack designed for the printer. The pack contains
a set of print paper and a print cartridge for either Post Card size (4x6 inch) or
Small size (3.5x4 inch) prints.
Select the printing pack according to the type of printing you intend to do:

Printing pack Contents

SVM-25LS 25 sheets of Post Card size photo paper/Print cartridge for
25 prints

SVM-25LW 25 sheets of Post Card size sticker/Print cartridge for 25
prints

SVM-30SS 30 sheets of Small size photo paper/Print cartridge for 30
prints

SVM-30SW 30 sheets of Small size stickers/Print cartridge for 30 prints

SVM-30SW09 30 sheets of Small size 9-split stickers/Print cartridge for 30
prints

Notes

•Use the printing pack for this printer only.
•Always use the print cartridge designed for the size of the print paper you use.  If

you mix cartridges and paper of different types or size, printing may not be
possible, or a paper jam or other trouble may occur.

•Do not use the same print paper or print cartridge twice.  Otherwise, a malfunction
or breakdown may occur.

•Do not touch the ink ribbon of the print cartridge or the printing surface of the print
paper. If there are fingerprints or dust on the printing surface or the ink ribbon, the
printing quality may deteriorate.

•For high quality prints, avoid placing the printing pack in locations that are subject
to high temperature, high humidity, excessive dust, or direct sunlight.

•When storing a partially-used pack of the print cartridge and print paper, store it in
its original bag or in a similar container.
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POWER

3 Loading the print cartridge

1 Press the POWER button to turn on the printer.
The POWER indicator lights in green.

2 Pull and open the cartridge compartment lid.

3 Insert the print cartridge into the printer firmly until it clicks
into place and close the cartridge compartment lid.

The side with the Sony logo

Continued
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3 Loading the print cartridge

To replace the print cartridge
When the print cartridge runs out, the  cartridge error indicator lights and
an error message appears on the screen.
Open the cartridge compartment lid, push up the eject lever, remove the used
print cartridge, and then insert a new cartridge.

Notes

•Never put your hand into the cartridge compartment. The thermal head reaches
high temperatures, especially after repeated printing.

•Do not use the same print cartridge twice.  Otherwise, a malfunction or breakdown
may occur.

•If the print cartridge does not click into place, remove it and
then re-insert it.  If the ink ribbon is too slack to be loaded,
wind the ink ribbon in the direction of the arrow to remove
the slack.

•If the print cartridge is not loaded when you turn on the printer, the  cartridge
error indicator lights up.

•When placing the print cartridge on a desk or other surface, stand it vertically so
that dust will not get on the ink ribbon.

•Do not touch the ink ribbon or place the print cartridge in a dusty location.
Fingerprints or dust on the ink ribbon may result in imperfect printing.

•Do not change the print cartridge while operating the printer.

Notes on storing the print cartridge

•Avoid placing the print cartridge in a location subject to high temperatures, high
humidity, excessive dust or direct sunlight

•When you are going to store a partially-used cartridge, store it in its original bag.

 cartridge error
indicator

Eject lever
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Partition

4 Inserting the print paper

1 Open the paper tray lid and set the partition according to the
print paper size you want to use.
To use Post Card size paper, lay the partition down .
To use Small size paper, stand the partition upright.

2 Set the print paper into the tray.
Riffle the print paper. Then insert the print paper with its printing surface
(the side with no imprint) facing up and the arrow pointing in the same
direction as the arrow in the tray.
When inserting paper, insert the protective sheet together with paper into
the tray.  After you have placed the paper into the tray, remove the
protective sheet.
You can set up to 25 sheets for Post Card size and 30 sheets for Small size
print paper.  When inserting Small size print paper, set it behind the
partition.

Note

Do not touch the printing surface. Fingerprints on the printing surface may result
in imperfect printing.

Continued

When inserting Small
size print paper

Printing surface

Arrow

Paper

Front side
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4 Inserting the print paper

3 Close the paper tray lid.  Then push and open the printer’s
paper tray compartment lid and  insert the paper tray into the
printer.
Insert it firmly until it clicks into place.

Notes

•If print paper does not feed automatically, the paper error indicator lights.  Pull
out the paper tray and check for a paper jam.

•When adding print paper to a partially full tray, make sure that the total number of
sheets does not exceed 25 for the Post Card size or 30 for the Small size print paper.
Do not place different types or sizes of paper in the tray.  Otherwise, a paper jam or
malfunction may occur.

• If the print paper runs out when you press PRINT, a warning sound beeps and the
paper error indicator lights.

•Do not write or type on the printing surface of the paper before printing. If you
want to write greetings or draw on the printed surface after printing, use an oil ink
pen.

•Do not attach stickers or anything else on the printing surface before printing.
•Do not remove the backing from sticker print paper before printing is completed.

Otherwise, jams or printer damage may occur.
•Do not print on the same print paper twice.  Otherwise, a malfunction or

breakdown may occur.
•Avoid storing the paper with the printed faces touching each other or in contact

with rubber or plastic products including vinyl chloride or plasticizer for an
extended period of time;  color changes or deterioration of the printed image may
occur.

•Before printing, do not fold or bend the print paper.

Notes on storing the print paper

•Avoid placing the print paper in a location subject to high temperatures, high
humidity, excessive dust or direct sunlight

•When you are going to store partially-used print paper, store it in its original bag.
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POWER

MEMORY
STICK

PC
CARD PC

MEMORY
STICK

PC
CARD PC

ContinuedOperation panel

Yellow frame (cursor)

Basic printing operations

Printing selected images

You can select an image recorded in the “Memory Stick” or PC card and print
it at full-size (standard print).

Borderless
standard print

3–6

7
Input indicators

2

1

1 Insert a “Memory Stick” or PC card with recorded images into
the “Memory Stick” or PC card insertion slot (page 14).

2 Press the POWER button to turn on the printer.
The POWER indicator lights in green.

When you connect your printer to your television

Turn on the television and set the input selector of the television to “VIDEO.”  The
printer images are displayed on the television.

3 Tap [INPUT SELECT] on the operation panel repeatedly with the
supplied stylus until the “MEMORY STICK” or PC CARD
indicator turns on.
Thumbnails of the images stored in the “Memory Stick” or PC card are
displayed on the screen.

Or
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4 Tap the image you want to print on the screen.
The cursor moves to the tapped image.  You can also tap the arrows [B/b/
V/v] to move the cursor (page 13).

To display another page

When multiple pages exist, you can switch pages. To display the next page, tap the
lower part of the scroll bar or tap [v] repeatedly.  To display the previous page, tap
the upper part of the scroll bar or tap [V] repeatedly.

To display a preview image

While the cursor is on the image, tap the image again or tap [PICTURE].
A preview of the selected image is displayed.

To display a preview of different images, tap the arrows [B/b/V/v].  The
preview of  the previous (B), next (b), upper (V) or lower (v) image is
displayed.
To display the thumbnails again, tap anywhere on the preview image or
tap [PICTURE].

Note

While the screen display is switching or the printer is accessing the “Memory Stick”
or PC card (with the relevant input indicator blinking), do not eject or insert the
“Memory Stick” or PC card. Otherwise, they may crash.

Printing the selected image
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Print quantity

5 Tap [ENTER] or PRINT QUANTITY [+].
The image is selected and its frame turns orange.  The print quantity
becomes “1.”

6 Tap PRINT QUANTITY [+] or [–] to set the number of copies to
be printed.
Each time you tap [+] or [–], the print quantity increases or decreases.  You
can set the print quantity from 0 to 30.

To cancel the selection

Tap [–] repeatedly until the print quantity becomes “0.” The orange frame
disappears and the selection is canceled.

To print multiple images at a time

Repeat steps 4 through 6 to select other images and set the desired print quantity
for each of them.

Continued

Orange frame (selection)
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PRINT

Printing the selected image

7 Press the PRINT button.
Printing starts. During printing, the PRINT indicator lights.  The printing
process bar and the approximate printing time are displayed on the screen.

When you start printing while the preview image is displayed

An dialog box appears to ask whether you want to print the image being displayed
or all the selected images.  Tap to select either of the two options to start printing.

To stop printing

Tap [Cancel] on the screen or tap [ENTER] on the operation panel. Printing from
the next print will be canceled.

8 When printing ends and the print paper automatically emerges
from the paper outlet, remove the printed paper from the
printer.

Notes

•When the “MEMORY STICK” or PC CARD indicator blinks or the data access message
appears, do not eject the “Memory Stick” or PC card. Otherwise, they may crash.

•While printing, never move or turn off the printer;  the print cartridge or paper may
become stuck.  If this happens, turn the printer off and on, and resume printing from
the beginning.

•While printing, the print paper is partially ejected from the paper outlet in stages.
Never pull out the paper forcibly until the PRINT indicator turns off and the print
paper emerges automatically.

•When using Small Size stickers, do not leave more than 10 sheets of the ejected
printed paper on the paper tray.

•Depending on the file type and size of an image, it may take from 5 to 60 seconds to
display a preview image on the screen.

•Depending on the type of digital still camera, it may take some time for the
thumbnail list to be displayed.

•When the width or height of an image is smaller than 480 dots, the
image is displayed in a small size.  You can print the image but the
printing quality is rough due to its small image size.

•When you view the printer’s images on a large-screen television, the pictures may be
distorted.  To view them in better picture quality, display the preview image.

•When using your printer in low ambient temperatures, the black lines may be
displayed on the LCD display, which is not of a printer’s malfunction.  You can print
an image without problem.
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1 Insert the “Memory Stick” or PC card storing the images into
the “Memory Stick” or PC card insertion slot (page 14).

2 Press the POWER button to turn on the printer.
The POWER indicator lights in green.

When you connect your printer to your television

Turn on the television and set the input selector of the television to “VIDEO.”  The
printer images are displayed on the television.

3 Tap [INPUT SELECT] on the operation panel repeatedly until the
“MEMORY STICK” or PC CARD indicator turns on.
Thumbnails of the images stored in the “Memory Stick” or PC card are
displayed on the screen.

Continued

3
5
4

Input indicators

2

1

Printing all images or DPOF preset images at
one time

You can print all the images stored in a “Memory Stick” or PC card at one
time.  You can also print multiple images preset by your digital still camera
(DPOF) at one time.

What is “DPOF”?

The “DPOF” (Digital Print Order Format) is a format used to record the information
necessary for automatically printing images shot with a digital still camera at a printing
shop or with a home-use printer. The printer can automatically print the preset number
of copies of the images preset with DPOF.  For details, see the operating instructions of
the digital still camera you are using.
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Printing all images or DPOF preset images at one time

4 Do either of the following:

• To print all the images, press the ALL button.

• To print the preset images, press the DPOF button.
When you select All, all the images in the thumbnail list are displayed
with an orange frame.  When you select DPOF, only the preset images are
displayed with an orange frame.

5 Press the PRINT button.
Printing starts. When you select All, all the images in the “Memory Stick”
or PC card are printed one by one in the order of their image numbers.
When you select DPOF, the preset images are printed.

To stop printing

Tap [Cancel] on the screen or tap [ENTER] on the operation panel. Printing will be
canceled from the next print.

6 When printing ends and the print paper automatically emerges
from the paper outlet, remove the printed paper from the
printer.
For notes giving further information during or after printing, see page 26.

To return to the usual printing mode
Press the ALL or DPOF button again.

ALL
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Advanced printing operations

Adding effects to an image

What you can do with the Effect menu

The Effect menu allows you to edit, adjust or add special filters to an image.

To display the main Effect menu, tap [EFFECT] on the operation
panel:

Tap the Effect sub menu item and add an effect to an image.

Sub menu Functions

Edit Enlarges, reduces, rotates, or flips an image horizontally.
(Page 31)

Adjustment Adjusts the brightness, color depth, tint, and sharpness
of the image. (Page 32)

Filter Adds a special filter to an image to print monochrome,
sepia, or painted pictures. (Page 34)

Tool Adds freehand drawings, stamps or input characters to
an image. (Page 36)

Exit Exits the Effect menu.

To save the image with the selected effects
Tap [Exit] in the main Effect menu or [Effect] either in the Effect main or sub
menus.  When a dialog box for saving is displayed, tap [Yes] to save the edited
image or [No] to cancel it.
When both a “Memory Stick” and a PC card are inserted, a dialog box to select
the destination is also displayed.  Tap the desired destination.

Continued
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Adding effects to an image

Notes

•If the “Memory Stick” or PC card is in write protect status, you cannot save an image
in the “Memory Stick” or PC card.

•While saving the image, do not turn off the power or remove the “Memory Stick” or
PC card from the insertion slot.  The “Memory Stick” or PC card may be damaged.

To print the edited image
Tap PRINT QUANTITY [+] or [–] to set the copies to be printed and then press
the PRINT button in the Effect main or sub menus.  The currently displayed
image will be printed.

Notes

•It may take longer to process an edited image after you press the PRINT button.
•Do not remove the “Memory Stick” or PC card while in the Effect mode.  If you do,

the Effect mode ends forcibly and any editing you have done is canceled.

To change the printer settings midway
You can tap [MENU] and change the settings.
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Continued

Changing the image size and position

The Edit sub menu allows you to enlarge, reduce, rotate, or flip an image.

1 Select the image to be edited in the thumbnail list or tap the
selected image or [PICTURE] to display its preview.

2 Tap [Effect].
The main Effect menu is displayed.

3 Tap [Edit].
The Edit sub menu is displayed.

4 Tap the desired item to edit the image.

Item Procedures

Zoom –/+ Each time you tap [+] or [–], the image is enlarged
or reduced.

Move Tap [Move] and then tap the arrows [B/b/V/v] to
move the image in the desired direction. Then tap
[ENTER] to fix the position.

Rotate 90° Each time you tap [Rotate 90°], the image rotates
90° clockwise.

Mirror Each time you tap [Mirror], the image flips
horizontally.
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Adding effects to an image

Note

The picture quality of an enlarged image may be deteriorated depending on the size
of the image.

5 Tap [Back].
The main Effect menu is displayed again. You can select another Effect sub
menu, save or print the image, or exit the Effect menu (page 29).

Adjusting the pictures

The Adjustment sub menu allows you to adjust brightness, color deepness,
tint, or sharpness levels of the image pictures.

1 Select the image to be adjusted in the thumbnail list or tap the
selected image or [PICTURE] to display its preview.

2 Tap [Effect].
The main Effect menu is displayed.

3 Tap [Adjustment].
The Adjustment sub menu is displayed.
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4 Tap the desired adjustment item.
The adjustment screen of the selected item is displayed.

5 Tap the upper or lower part on the slider to adjust the image.

Items Procedures

Brightness Tap the lower part of the slider to darken the image or
the upper part to brighten the image.

Color Depth Tap the lower part of the slider for light colors, or the
upper part for deep colors.

Tint Tap the lower part of the slider to make the image
reddish, or the upper part to make the image bluish.

Sharpness Tap the lower part of the slider for weaker sharpness, or
the upper part for dark colors.

Tip

To adjust the level, you can also use the arrows [V/v].

Notes

•The dispaly reflects the adjustment only after you tap [Back].  You cannot make
adjustments while viewing the screen.

•The picture quality of the image being displayed on the screen may differ from
that of the printed image.

Continued
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Adding effects to an image

6 Tap [Back] .
The Adjustment  sub menu is displayed again.  You can select another
adjustment item to proceed with further adjustments.

7 Tap [Back].
The main Effect menu is displayed again. You can select another Effect sub
menu, save or print the image, or exit the Effect menu (page 29).

Adding a special filter to an image

The Filter sub menu allows you to add a special effect to an image to print in
monochrome, paint, or sepia tone.

1 Select the image to be filtered in the thumbnail list or tap the
selected image or [PICTURE] to display its preview.

2 Tap [Effect].
The main Effect menu is displayed.

3 Tap [Filter].
The Filter sub menu is displayed.
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4 Tap a filter you want to add to an image.

Items Filters

Paint Makes the image look like a painted picture.

Sepia Makes the image look like an old photograph with faded
colors.

Monochrome Makes the image into a monochrome picture.

Normal Removes any added filter(s) from the image.

Note

The picture of the image being displayed on the screen may differ from that of the
printed image.

5 Tap [Back].
The main Effect menu is displayed again. You can select another Effect sub
menu, save or print the image, or exit the Effect menu (page 29).
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Adding drawings, stamps, or characters (Tool)

What you can do with the Tool sub menu

The Tool sub menu allows you to add freehand drawings, or input selected
stamps or characters to an image.
Follow the procedures below to display the Tool sub menu.

To display the Tool sub menu, tap [Tool] in the main Effect menu
(page 29) or CREATIVE PRINT menu (page 45).

Tap the desired tool in the Tools box and draw freehand lines, put on stamps,
or input character in the preview.

Icons Tools Functions

Pencil Draws freehand line art on the preview.

Color Displays the color selection screen to apply a color to the
pencil drawings.

/ Weight Tap either of the stroke weights for the pencil drawings:
 (thin) or  (thick).

Stamp Displays the stamp selection screen showing stamps to be
pasted to the image.

Type Displays the character input screen to select characters to
be added to the image.

/  Size Tap  to make the size of typed characters or stamp
larger, or tap  to make it smaller.

Redraw Cancels the drawings, stamps, or input characters.

Done Fixes the drawings, stamps, or input characters.
Tapping again exits the Tool sub menu.

Preview Tools box
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To exit the Tool sub menu
Tap [Done].  When the dialog box used for saving the image is displayed, tap
[Yes] to save the edits or [No] to cancel them.
When both a “Memory Stick” and a PC card are inserted, a dialog box to select
the destination is also displayed.  Tap the desired destination.

To print the edited image
Tap PRINT QUANTITY [+] or [–] to set the copies to be printed and then press
the PRINT button in a Tool sub menu.  The currently displayed image will be
printed.

Notes

•Do not change the print cartridge while operating the printer.
•Do not remove the “Memory Stick” or PC card while in the Tool sub menu mode.  If

you do, the Tool sub menu mode ends forcibly and any edits you have made are
canceled.

•If the “Memory Stick” or PC card is in write protect status, you cannot save an image
on the “Memory Stick” or PC card.

•During saving the image, do not turn off the power or remove the “Memory Stick” or
PC card from the insertion slot.  The “Memory Stick” or PC card may be damaged.
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Adding drawings, stamps, or characters (Tool)

Drawing freehand line art ( )

You can use the pencil tool to draw freehand line art on an image.

1 In the Tool sub menu (page 36), tap  (Pencil tool).
The pencil tool mode is selected.  The tool button turns orange.

2 To select the stroke weight for the pencil drawings, tap 
(thin) or  (thick).

3 To select the color for the pencil drawings, tap  (Color).
The color selection screen is displayed.

4 Tap the desired color box.
The color tapped is selected and the color selection screen is closed.

5 Tap and draw a freehand line on the preview.
The line formed from the point you start drawing to the point you lift the
stylus becomes a stroke.

To erase the drawing

Tap [Redraw].  The drawing just made is erased from the preview.

To display the preview image only

Tap [PICTURE] on the operation panel.

Only the preview image is displayed.  To return to the previous screen, tap
[PICTURE] or tap anywhere on the preview image.
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6 Tap [ENTER].
The drawing you made is fixed and pasted to the image.

Note

Once you tap [ENTER], you cannot delete the drawing.

7 Repeat steps 2 through 6 to draw other line art.
The drawings are pasted on the image in the same manner.

8 Tap  (Pencil tool) to release the pencil tool mode.
The tool button turns yellow.
You can use another tool, exit the Tool menu, or print the image (page 36).
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Adding drawings, stamps, or characters (Tool)

Pasting stamps ( )

You can use the stamp tool to paste selected stamp(s) to an image.

1 In the Tool sub menu (page 36), tap  (Stamp tool).
The stamp selection screen is displayed. The tool button turns orange.

2 Tap the desired stamp.
The tapped stamp is selected and the stamp selection screen is closed.

3 Tap on the preview image where you want to paste the stamp.
The selected stamp is pasted onto the preview image in an all black
silhouette.

4 To adjust the stamp size, tap  to make it larger or  to make
it smaller.

To erase the stamp

Tap [Redraw].  The stamp just pasted is erased from the preview.
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To move the stamp

Tap the arrows [B/b/V/v] to move the stamp in the desired direction.

5 Tap [ENTER].
The stamp is fixed to the image.

Note

Once you tap [ENTER], you cannot move or delete the stamp.

6 To paste the same stamp(s), repeat steps 3 through 6.
The stamps are pasted on the image.

7 Tap  (Stamp tool) to release the stamp tool mode.
The tool button turns yellow.
You can use another tool, exit the Tool menu, or print the image (page 36).
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Adding drawings, stamps, or characters (Tool)

Typing characters ( )

You can use the type tool to input characters to an image. Characters are input
one line at a time.

1 In the Tool sub menu (page 36), tap  (Type tool).
 The tool button turns orange. The character input screen is displayed.

Character input box

To switch the characters input screens

To display the Symbolic input screen, tap [Symbolic].  To return to the
alphanumeric characters input screen, tap [Alphanumeric].  Switch the screens as
you like.

2 Tap the characters you want to input in the character table.
The tapped characters are displayed in highlight in the input box.

To select a capital letter

Tap [Caps] to display the capital letters table.  Then tap the desired character.  To
enter a small letter, tap [Caps] again.

To select the font

The characters are input in the font displayed next to [Font].  To select a different
font, tap [Font] until the desired font is displayed.

Switch the Alphanumeric and Symbolic
input screens.

Select color and font (5 fonts available)
for the characters.

Character table
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To select the color

The characters are input in the color displayed next to [Font Color].  To select a
different color, tap [Font Color] and then tap the desired color box on the color
selection screen.

To delete characters in the input box

•To delete a character before the cursor, tap [Delete].  Each time you tap [Delete],
the character before the cursor is deleted.  Input a new character.

•To delete a character in the middle of the input box, tap the space after the
character you want to delete.  The [Insert] button turns orange and the orange
cursor appears after the character.   (You can also tap [Insert] and then tap the
arrows [B/b] to move the cursor after the character you want to delete.)

Then tap [Delete] to delete the character.  Each time you tap [Delete], the
character before the cursor is deleted.  You can then input a new character.  To
release insertion mode and place the cursor to the end of the line, tap [Insert].

3 Enter the remaining characters for the line and then tap [Exit].
The character input screen is closed.

4 Tap on the preview where you want to paste the line of input
characters.
The line of input characters is pasted onto the preview in a silhouette.

Continued
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Adding drawings, stamps, or characters (Tool)

5 To adjust the character size, tap  to make it larger or  to
make it smaller.

To erase the characters input

Tap [Redraw].  The characters just pasted are erased from the preview.

To move the characters

Tap the arrows [B/b/V/v] to move the characters in the desired direction.

6 Tap [ENTER].
The characters are fixed to the image.

Note

Once you tap [ENTER], you cannot move or delete the characters.

7 To input the same character(s), repeat steps 4 through 6.
The characters are pasted on the image.

8 To input different character(s), repeat steps 1 through 6.

9 Tap  (Type tool) to release the type tool mode.
The tool button turns yellow.
You can use another tool, exit the Tool menu, or print the image (page 36).
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Making various prints (CREATIVE PRINT)

What you can do with the Creative Print menu

The Creative Print menu allows you to make a variety of prints.

To display the main Creative Print menu, tap [CREATIVE PRINT] on
the operation panel:

Tap the Creative Print sub menu item and make a variety of prints.

Sub menu Functions

Card Adds a selected greeting and your input message to
make an original card. (Page 47)

Calendar Add a calendar of selected month(s) to an image or
images to make an original calendar. (Page 51)

Split Images Makes 4-split or 9-split images prints. (Page 53)

Sticker Makes 9-split image sticker. (Page 55)

Index Print Makes an index print of all the images stored in the
“Memory Stick” or PC card. (Page 57)

Exit Exits the Creative Print menu.

During or after the Creative Print procedures

To add drawings, stamps, or characters to the Creative Print image
For all the Creative Print sub menus except the Index Print sub menu, you can
tap [Tool] displayed on the screen and use the Tool menu to add drawings,
stamps, or characters to an image.  For details, see “Adding drawings, stamps,
or characters (Tool)” on page 36.

Continued
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Making various prints (CREATIVE PRINT)

To display the preview image only
Tap [PICTURE] on the operation panel.
Only the preview image is displayed.  To return to the previous screen, tap
[PICTURE] or tap anywhere on the preview image.

To print the Creative Print image
Tap PRINT QUANTITY [+] or [–] to set the copies to be printed and then press
the PRINT button.  The currently displayed Creative Print image will be
printed.

Notes

It may take longer to process a created image after you press the PRINT button.

To exit the Creative Print menu
Tap [Exit] in the main Creative Print menu or [CREATIVE PRINT] both in the
Creative Print main and sub menus.  When the dialog box used for saving
images is displayed, tap [Yes] to save the image or [No] to cancel the image.

To save the Creative Print image
Tap [Save] on the screen.  When the dialog box used for saving images is
displayed, tap [Yes] to save the edited image or [No] to cancel it.
When both a “Memory Stick” and a PC card are inserted, the dialog box used
to select the destination is also displayed.  Tap the desired destination.

Notes

•If the “Memory Stick” or PC card is in write protect status, you cannot save an image
in the “Memory Stick” or PC card.

•While saving the image, do not turn off the power or remove the “Memory Stick” or
PC card from the insertion slot.  The “Memory Stick” or PC card may be damaged.

To change the printer settings midway
You can tap [MENU] and change the settings.
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Making a card

You can add a greeting and your own message to images and
make an original card like the one shown on the right.

1 Tap [Card] in the main Creative Print menu.
The print size selection screen is displayed. Select the print paper size you
want to use.

To return to the main Creative Print menu

Tap [Back].

2 Tap the desired paper size icon.
The screen used for selecting a template of the selected paper size is
displayed.

To return to the previous screen

Tap [Back].  You can redo the operations from the previous screen.
Continued
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Making various prints (CREATIVE PRINT)

Greeting area

3 Tap the desired template.
A preview of the selected template is displayed.  The preview allows you
to check the preceding procedures.

4 Tap each area on the preview to enter a greeting, image(s), or
characters.
You can choose them in any order.

x Entering a greeting

1 Tap the greeting area.

The screen used for selecting a greeting is displayed.

2 Tap the desired greeting.

The color selection window for the greeting is displayed.

3 Tap the desired color box.

A preview reflecting your selections up to the preceding step is
displayed.  The greeting is displayed in the selected color.

Character input area

Image area
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x Entering characters

When you choose a template with characters, you can enter your own
characters.  Tap the character input area to display the character input
screen.  For how to input characters, see “Typing characters” on page 42.

x Selecting image(s)

1 Insert a “Memory Stick” or PC card into the printer and tap an
image area.
The thumbnail list used for selecting an image is displayed.

2 Tap the desired image.

The screen used to adjust the image size, position, angle, and brightness
is displayed.

3 Tap the desired adjustment button and make your adjustments.

For details, see “Changing the image size and position” (page 31) and
“Adjusting the pictures” (page 32).

Continued
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Making various prints (CREATIVE PRINT)

4 Tap [Done].

A preview reflecting your selections up to the preceding step is
displayed.  The selected image is displayed in the image area. When
you choose a template with multiple images, repeat steps 1 through 4 to
select the remaining image(s) for each image area.

5 Check the preview and perform any of the procedures
explained in “During or after the Creative Print procedures” on
page 45.
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Continued

Making a calendar

You can add a selected calendar to an image or images
to make an original calendar.

1 Tap [Calendar] in the main Creative Print menu.
The print size selection screen is displayed. Select the print paper size you use.

To return to the main Creative Print menu

Tap [Back].

2 Tap the desired paper size icon.
The screen used for selecting a calendar template for the selected print
paper size is displayed.

To return to the previous screen

Tap [Back].  You can redo the operations from the previous screen.

3 Tap the desired template.
A preview of the selected template is displayed.  The preview allows you
to check the preceding procedures.

Image area

Calendar area
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Making various prints (CREATIVE PRINT)

4 Tap each area on the preview to set the calendar and add
image(s).
You can choose them in any order.

x Selecting image(s)

Tap the image area to select and adjust an image.  For details, see
“Selecting image(s)” on page 49.

x Setting the calendar

1 Tap the calendar area.

The screen used for setting the calendar is displayed.

2 In the “Start Month” line, set the year and month to start the
calendar.
Tap the month box and tap v/V above and below the month box to set
the month. Then tap v/V above and below the year box to set the year.

3 In the “Start Date” line, set the day starting the week (placed
furthest left in the calendar).
Tap [Sunday] or [Monday].

4 In the “Color of Day” line, set the color of the days.

Tap [Sunday in red] or [Sunday in red/Saturday in blue].

5 Tap [Done].

A preview of the calendar is displayed.  The selected calendar is
displayed in the calendar area.

5 Check the preview and perform any of the procedures
explained in “During or after the Creative Print procedures” on
page 45.
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Continued

Making a split print

You can make a print with 4-split, 9-split, or 16-split images.

1 Tap [Split Images] in the main Creative Print menu.
The print size selection screen is displayed. Select the print paper size you
use.

To return to the main Creative Print menu

Tap [Back].

2 Tap the desired paper size icon.
The screen for selecting the split image template for the selected print
paper size is displayed.

To return to the previous screen

Tap [Back].  You can redo the operations from the previous screen.
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Making various prints (CREATIVE PRINT)

3 Tap the desired template.
The preview of the selected template is displayed.  The preview allows
you to check the preceding procedures.

4 Tap an image area.
When you choose a template with multiple images, you can select from
any image area.

5 Select and adjust an image.
For details on selecting an image, see “Selecting image(s)” on page 49.

6 Check the preview and perform any of the procedures
explained in “During or after the Creative Print procedures” on
page 45.
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Continued

Making a sticker

You can add a frame to each of the 9-split images to make a
9-split image sticker.

Note

You can make a sticker using Small size print paper only.  Before you start making a
sticker, insert Small size print paper into your paper tray.

Making a 9-split image sticker with a frame

1 Tap [Sticker] in the main Creative Print menu.
The screen used for selecting a sticker template for the Small size print
paper is displayed.

To return to the main Creative Print menu

Tap [Back].

2 Tap the desired 9-split template.
A preview of the selected template is displayed.  The preview allows you
to check the preceding procedures.
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3 Tap an image area.
When you choose a template with multiple images, you can select from
any image area.  The screen used for selecting a frame is displayed.

4 Tap the desired frame.
The screen used for selecting an image is displayed.

5 Select and adjust the desired image.
For details on selecting an image, see “Selecting image(s)” on page 49.

6 Repeat steps 3 and 5 to add framed image(s) to the remaining
image area(s).

7 Check the preview and perform any of the procedures
explained in “During or after the Creative Print procedures” on
page 45.

Making a 9-split image sticker without a frame
To make a sticker without frames, choose [Split Images] in the Creative Print
menu and choose a Small size and then a 9-split template.

Making various prints (CREATIVE PRINT)
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Making an index print

You can make an index print of the images in the “Memory Stick” or PC card.

1 Tap [Index Print] in the main Creative Print menu.
The print size selection screen is displayed. Select the print paper size you
use.

To return to the main Creative Print menu

Tap [Back].

2 Tap the desired paper size icon.
The title selection screen is displayed.

3 In the Title line, tap either [On] to add a title or [Off] to add no
title.

Continued

 Note

Patterns differ depending on the paper size and whether you input a title
or not.

4 Tap the desired pattern of image alignment.
When you select [10 x 8], for example, 10 (horizontally) by 8 (vertically)
images are printed on a sheet of print paper.
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Making various prints (CREATIVE PRINT)

5 Tap [Done].
• When you select [On], the character input screen is displayed.  Enter a

title.  For how to input characters, see “Typing characters” on page 42.
After you enter your characters, the pattern setting screen is displayed.

• When you select [Off], the pattern setting screen is displayed
immediately.

6 Check the preview and press the PRINT button.
The index list of the “Memory Stick” or PC card images is printed in the
selected pattern along with any input title with corresponding image
numbers.  When  “Date Print” is selected, the shot date (year, month and
day) is also printed with the image.

Note

An image which is not displayed because it is damaged or has some kind of
problems will not be printed.

7 Tap [CREATIVE PRINT] to exit the Creative Print menu.
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Setting up the printer (MENU)

What you can do with the Menu

The Menu allows you to change the printer settings, set up the screen, perform
slideshow, or delete images.

To display the Menu screen, tap [MENU] on the operation panel:

Tap the Menu sub menu item and add an effect to an image.

Sub menu Functions

Set Up Change the printing preferences including the Auto
Fine Print 2, date print, finish, or borderless print
settings.  You can also set clock and beep.
 (Page 60)

Screen Setup Sets the video output and adjusts LCD display
contrast. (Page 63)

Slideshow Performs a slideshow of the images in the “Memory
Stick” or PC card. (Page 64)

Delete Image Deletes the selected image in the “Memory Stick” or
PC card.  Also formats the “Memory Stick.”
 (Page 65)

To exit the Menu
Tap [Exit] in a Menu screen or tap [MENU].  The screen displayed before you
entered the Menu screen returns.
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Changing the printer preferences (Set Up)

The Set Up sub menu allows you to change the printing preferences including
Auto Fine Print 2, date print, finish, or borderless print settings.  You can also
set clock and beep.

1 Tap [MENU].
The Menu screen (page 59) is displayed.

2 Tap [Set Up].
The Set Up sub menu is displayed.

3 Tap the setting items you want to select.
A green mark indicates the setting item has been selected.  (*:  Default
settings)

Setting the printer (MENU)
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Items  Settings  Contents

Date Print On Prints an image with the date recorded
together with the image shot with your
digital still camera.

Note

You can print the date only when the image’s date
data is recorded in the DCF (Design rule for
Camera File system) format.

Off* Prints an image without the date print data.

Auto Fine Print 2 On Corrects an image automatically for printing
in better picture quality, especially effective
for a dark or low-contrast image.

Note

• The image on the screen is not corrected.
• When printing from a computer, the Auto Fine

Print 2 function does not work.

Off* Prints an image without any corrections.

Beep On* The warning and operation sound beeps.

Off No warning or operation sound beeps.

Select Finish Border Prints an image with borders around the
image. (4:3 and 3:2 pictures will not be cut off
at the top and bottom.)

Borderless* Prints an image without borders around the
image.

Notes

• You cannot make borderless prints with Small
size print paper.

• When printing a 4:3 picture, the top and bottom
edges of the image are cut and it is printed as a
3:2 picture.

Glossy* Prints an image vividly with glossy finish.

Texture Prints an image softly with a uniform and
uneven finish.

Continued
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Setting the printer (MENU)

Items  Settings  Contents

Date/Clock You can set the internal clock to record the date you saved
setting the image in the “Memory Stick” or PC card.

1 Tap [Set Up].
2 Tap v/V above and below the day to set the day.
3 Tap the month box and tap v/V to set the month.
4 Set the year, the hour and minutes in the same way.
5 Tap [Set Up] again to start the internal clock.

Note

Items which cannot be changed are displayed in gray and cannot be selected.

4 Tap [Back].
The Menu screen is displayed again.
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Setting video output and LCD screen contrast

You can set the video output to a television and adjust the LCD screen contrast
of the printer.

1 Tap [MENU].
The Menu screen (page 59) is displayed.

2 Tap [Screen Setup].
The Screen Setup screen is displayed.

3 Set the video output or LCD screen contrast.

Item                  Settings

Video Output Tap either of the following to set the video output to
your television:
[On] :  Video signals are output to the connected
television so that you can view the images or menus
on the television.
[Off]:  Video signals are not output to a television and
no printer images are displayed on the television.

 Display Contrast Tap b/B or anywhere on the slider to adjust the LCD
level.  The adjustment takes effect until you make an
adjustment again.

4 Tap [Back].
The Menu screen is displayed again.
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Viewing a slideshow

You can perform a slideshow of the images saved in a “Memory Stick” or PC
card.  When you want to search for an image, you can find it easily using the
slideshow.

Note

Before you begin, make sure that neither the ALL nor the DPOF button is pressed.

1 Tap [MENU].
The Menu screen (page 59) is displayed.

2 Tap [Slideshow].
The Slideshow screen is displayed.

3 In the Switch Time line, tap [Quick] to switch images quickly or
[Slow] to switch them slowly.

4 Tap [Enter].
The images in the “Memory Stick” or PC card are displayed one after
another in the selected switch time like a slideshow.

To stop the slideshow
Tap anywhere on the screen or tap any button on the operation panel.

Notes

•Images will be switched with random effect patterns.
•Depending on the image, it may take time to be displayed.
•You cannot view the slideshow in the Creative Print or Edit mode.
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Deleting images

You can delete images in the “Memory Stick” or PC card. You can also format
the “Memory Stick.”

Notes

•During deleting or formatting, do not turn off the power or remove the “Memory
Stick” or PC card from the insertion slot.  The “Memory Stick” or PC card may be
damaged.

•If the “Memory Stick” or PC card is in write protect status, you cannot delete images
or format the “Memory Stick.”

•When you select [Delete Image], you cannot delete an image protected or preset by
DPOF.

•An image, once deleted, will be lost forever. Before deleting an image, double-check
that it is the right one.

•When formatting a “Memory Stick,” all the files including the image files will be
deleted.

•You cannot format a PC card.
•You cannot delete an image in the CREATIVE PRINT or EDIT mode.

Deleting selected image(s)

1 Tap [MENU].
The Menu screen (page 59) is displayed.

2 Tap [Delete Image].
The Delete Image screen is displayed.

Continued
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Deleting images

3 Tap [Delete Image].
The thumbnail list is displayed.  When you display a preview image in
step 1, the cursor is set to that image.

To return to the Menu screen

Tap [Back].

4 Tap the image that you want to delete and tap [ENTER] on the
operation panel.
A confirmation dialog box is displayed.

5 Tap [Yes] to delete the image or [No] to cancel deletion.
The selected image is deleted.  To delete other images, repeat steps 4 and
5.

6 To exit the Menu, tap [MENU].
The screen displayed before you enter the Menu screen returns.

Formatting a “Memory Stick”
You can format a “Memory Stick.” In step 3, tap [Format Memory Stick].
When the confirmation dialog box is displayed, tap [Yes] to proceed with
formatting or tap [No] to cancel formatting.
The “Memory Stick” is formatted and all the images and other files are deleted
at one time.
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Printing from your computer

Using your printer with Windows computers

The supplied software enables you to print an image stored on your
computer’s hard disk with the Digital Photo Printer DPP-SV77.  You can also
view, copy, or transfer images stored in a “Memory Stick” or PC card inserted
in the printer from your computer’s monitor. To print an image from the
computer, you need commercially available printing application software.

System requirements

To use the supplied software, you need a computer that meets the following
system requirements:

OS: Microsoft Windows 98/Windows 98SE/Windows Me/
Windows 2000 Professional should be pre-installed.

Note

We cannot guarantee any operations with a computer where
Windows 3.1 or Windows 95 has been upgraded to Windows 98
or Windows 98 has been upgraded to Windows Me.

CPU: MMX Pentium 200 MHz or above is recommended.
RAM: 32 MB or more (64 MB or more is recommended.)
Hard disk space: 50 MB or more (Depending on the number of copies to

be printed.)
Port: A USB port should be installed as standard.
Drive: CD-ROM drive (for software installation)

Notes

• We cannot guarantee printer operations when a hub is used or when two or more
USB devices are connected to your computer.

• If you connect more than one DPP-SV77 printer at the same time, you cannot operate
the printer.

• You cannot operate the printer from another USB device being used simultaneously.
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Installing the software

Install the printer driver and Memory Stick/PC card reader software
contained on the supplied CD-ROM to your computer’s hard disk.

When using Windows 98/98SE/Me

Installing the USB driver

1 Turn on your computer and the printer.

2 Start Windows and then connect your computer and the
printer.
When the computer detects the printer, the “Add New Hardware Wizard”
dialog box is displayed.
For the proper connections, refer to “Connecting to a computer (optional)”
on page 16.

Note

Close all programs before running the installer.

3 Click “Next.”
The dialog box to used select searching method appears.

4 Check “Search for the best driver for your device
(Recommended).” and click “Next.”
The dialog box to used specify the driver location is displayed.

Using your printer with Windows computers
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5 Insert the supplied CD-ROM into your CD-ROM drive and check
“CD-ROM drive.”  Then click “Next.”
Installation starts.  When installation ends, the “Finish Setup” dialog box
appears.

Note

During installation, you may be asked to insert the Windows OS CD-ROM.

6 Click “Finish.”
The Sony DPP-SV77 USB driver is installed.

Note

After you click “Finish,” you may be prompted to restart the computer.

To check the installation

1 Click “Start,” point to “Settings” and then click “Control Panel.”
The “Control Panel” window is displayed.

2 Double-click “System.”
The “System Properties” window is displayed.

3 Click a “Device Manager” tab.
When  “Sony DPP-SV77 USB Digital Photo Printer” is listed under “Universal serial
bus controller,” installation is completed successfully.

Continued
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Using your printer with Windows computers

Installing the printer driver and reader software

1 Insert the supplied CD-ROM into your CD-ROM drive and click
“Start,” and then click “Run.”
The “Run” dialog box is displayed.

2 Input “D:\Setup.exe” (When your CD-ROM drive is the D: drive)
then click “OK.”
If your CD-ROM drive is not the D: drive, input the appropriate drive name.
You can also input the location of the installer by clicking the “Browse” button.
The installer automatically starts, and the language selection dialog box appears.

3 Select the language for the application, then click “OK.”
The “Welcome” dialog box appears.

4 Click “Next.”
The “Choose Destination Location” dialog box is displayed.  The files are
factory-set to install the “C:\Program Files\Sony\DPPSV77” folder.  If
you want to install them to another folder, input the destination folder or
specify the destination folder by clicking the “Browse” button.

5 Click “Next.”
 “Add Printer Wizard” starts up.

6 Click “Next.”
The dialog box used to select the printer connection is displayed.
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7 Check “Local printer” and  click “Next.”
The dialog box used to select the manufacturer and model of the printer is
displayed.

8 Click “Have Disk.”
The “Install From Disk” dialog box is displayed.

9 Click “Browse.”
The following dialog box is displayed.

10 In the Drives box, select the CD-ROM drive.
The following dialog box is displayed.

11 In the Folders box, select your language folder and then
“WIN98” folder.

12 Make sure that “DPPSUSB.inf” is selected in the File name box
and then click “OK.”
The dialog box to select the model name is displayed.

Continued
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Using your printer with Windows computers

13 Select “Sony DPP-SV77” and click “Next.”
Copying of files starts. The dialog box used to select the port is displayed.

Note

During installation, you may be asked to insert the Windows OS CD-ROM.

14 Select “Sony DPPUSB1: Sony Digital Photo Printer” in the list
and click “Next.”
The dialog box used to select the printer name is displayed.  It is factory-
set to “Sony DPP-SV77.”  If you want to use another name, input the name
in the text box.

15 Click “Finish.”
The “Setup Complete” dialog box is displayed.

16 Click “Finish.”
The printer driver and reader software are installed.  The readme file is
displayed.
“Sony DPP-SV77” is added to the “Printers” window.

Notes

• After installation, the “Sony DPP-SV77” is not set as the default printer.  Set the
printer you use for each application.

• After you click “Finish,” you may be prompted to restart the computer.

When using Windows 2000 Professional
To use your DPP-SV77 with a computer which has Windows® 2000
Professional installed, you need to follow the procedures below to install the
USB driver and the printer driver onto your computer.

1 Start Windows 2000 Professional, and log on your computer as
the user name “Administrator”.
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2 Turn on the printer and then connect the printer and the
computer via their USB ports.

Note

Make sure to turn on your printer before connection.

3  Wait for the USB driver to be installed automatically and for the
following dialog box to disappear.

Note

If the “Add New Hardware Wizard” dialog box is displayed instead of the
above window, follow the instructions on the screen to install the “USB
Printing Support.”  When the dialog box asking where to search for the
driver files appears, uncheck all the options and click “Next.”

4 Insert the supplied CD-ROM into the CD-ROM drive of your
computer.

5 Double-click “Setup.exe” on the supplied CD-ROM.
The window used to select the driver language is displayed.

6 Select the language and click “OK.”
The “Welcome” dialog box appears.

7 Click “Next.”
The dialog box used to choose the destination folder is displayed.  The
files are factory-set to install to “C:\Program Files\Sony\DPPSV77”
folder.  If you want to install them to another folder, specify the
destination folder by clicking the “Browse” button.

Continued
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Using your printer with Windows computers

8 Click “Next.”
The “Setup Complete” dialog box is displayed.

9 Click “Finish.”
The Readme file is displayed.  “Sony DPP-SV77” is added to the “Printers”
window.

Notes

• If you cannot install the printer driver with the supplied setup program, see “About
the Printer Driver for Windows 2000 Professional” in the Readme file contained on the
supplied CD-ROM (“Readme\English\readme.txt).

• When you connect your printer to another USB port that is different from the port used
at the time of installation, an error message prompting you to input the directory for the
DPPSUSB.sys file may be displayed.  If this occurs, type the directory of the folder
where the Reader Software is installed (usually “C:\Program
File\Sony\DPPSV77\Program”) and follow the instructions on the screen to re-install
the files.

• After you click “Finish,” you may be prompted to restart the computer.

Uninstalling the software
When the software becomes unnecessary, you should remove the software
from your computer’s hard disk.  Uninstall the software using the following
procedures:

Uninstalling the “Sony DPP-SV77”

1 Disconnect the USB cable from the printer and the computer.

2 Click “Start,” point to “Settings” and then click “Control Panel.”

3 Double-click “Add/Remove Programs” in the “Control Panel” window.

4 On the “Install/Uninstall” tab of the  “Add/Remove Programs
Properties” window, select “Sony DPP-SV77” and click “Add/Remove.”

The confirmation dialog box is displayed.

5 Click “Yes.”

The relevant files are removed from your computer’s hard disk.

Uninstalling the printer driver

1 Disconnect the USB cable from the printer and the computer.

2 Click “Start,” point to “Settings” and then click “Printers.”

3 Right-click on  “Sony DPP-SV77” in the “Printers” window and select
“Delete” from the short-cut menu.
The confirmation dialog box is displayed.
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4 Click “Yes.”

The relevant files are removed from your computer’s hard disk.

Using the reader software

You can view the “Memory Stick” or PC card inserted in the printer as a drive
on your computer’s monitor.

1 In the “My Computer” or “Windows Explorer” window,
double-click “Sony DPP-SV77.”

2 Click “Memory Stick” or the PC card icon.
The images stored in the “Memory Stick” or PC card inserted in the
printer are displayed.  You can copy, transfer or save the “Memory Stick”
or PC card images just as you would any other Windows files.

Note

The reader software does not operate the DPP-SV77 as a completely removable medium.
When using the software, note the following restrictions:
• Before editing an image from the “Memory Stick” or PC card inserted in the printer,

store it on the computer’s hard disk.
If you double-click and open the file in the printer with its associated application and
edit it with the application, you cannot save the edition on the “Memory Stick” or PC
card with the application’s saving command.

• You cannot view or open the file in the printer using the “Open” command of an
application other than the reader software.

• You cannot run an execution file contained in the “Memory Stick” or PC card.



76 GB

Using your printer with Windows computers

Printing from a software application

You can use the “Print ”command of a software application to print an image
from your computer’s hard disk  with the DPP-SV77 Digital Photo Printer.

Notes

• This sections explains the settings and operations with a typical application as an
example.  Depending on the application, print settings and operations may differ.  For
the details, refer to the manual of your application.

• To get the print you expect, we suggest you use application software that allows you
to check the print preview.  Otherwise, make the image size 1664 (dots) x 2466 (dots)
and the resolution 403 dpi.

1 Start the application software that you use to print with, and
select the image to be printed.

2 Click “Print Setup” from the “File” menu of the application.
The “Print Setup” dialog box appears.

3 Set the printer.

The dialog box differs depending on the application.

1 Set “Printer” to “Sony DPP-SV77.”
2 Set “Paper Size.”

Choose When you make

Post Card (no margin) Post Card size borderless prints

Post Card Post Card size border prints

Small Small size prints

Select “Sony DPP-SV77” as the
printer.

Select the print paper size.

Select the image orientation.
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3 Set “Orientation.”
To print in portrait (tall) format, select “Portrait.” To print in landscape
(wide) format, select “Landscape.”

To set properties of the printer

Click “Properties” to display the “Properties” dialog box.
❒ Graphics tab

You can set the used resolution when printing an image.  You cannot
specify dithering, intension or color.

❒ Device Options tab
You can select finish from either “Glossy” or “Texture.”

4 Click “OK” to close the “Print Setup” dialog box.

5 Click “Print” from the “File” menu of the application.
The “Print” dialog box appears.

Print range Specify the pages to start and end printing.  To print all the
pages, select “All.”

Copies Enter the number of copies to be printed.

6 Set the print range and copies and click “Print.”
The printer starts printing.  To stop printing, click “Cancel.”
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Using your printer with Macintosh computers

The supplied software enables you to print an image from your Macintosh
with the Digital Photo Printer DPP-SV77. To print an image from the
computer, you need a commercially available printing software application.

System requirements

To use the supplied software, you need a Macintosh computer that must meet
the following system requirements.

OS: Mac OS 8.5.1/8.6/9.0/9.1 should be pre-installed.
Port: A USB port should be installed as standard.
RAM: 32 MB or more (64 MB or more is recommended.)
Hard disk space: 50 MB or more (depending on the number of copies to

be printed.)
Drive: CD-ROM drive (for software installation)

Notes

• We cannot guarantee the printer operations when a hub is used or when two or more
USB devices are connected to your computer.

• If you connect more than one DPP-SV77 printer at the same time, you cannot operate
the printer.

• You cannot operate the printer from another USB device being used simultaneously.

Installing the printer driver

Install the Sony DPP-SV77 Printer Driver Software Ver. 1.0 for Mac OS 8.5.1/
8.6/9.0/9.1 (“printer driver” in this manual) into your Macintosh.

1 Connect your Macintosh and the printer.
For the connections, refer to “Connecting to a computer (optional)” on
page 16.

2 Turn on the printer and start your Macintosh.

Note

Close all programs before running the installer.
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3 Insert the supplied CD-ROM into your CD-ROM drive.

4 Select the software language by double-clicking the
corresponding folder on the CD-ROM.
The selected language folder opens.

5 Double-click “Setup Program.”

6 Click “Install.”
Installation starts.  Follow the instructions on the screen to complete
installation.

Uninstalling the printer driver
When the software becomes unnecessary, remove the software as follows: In
step 6, click “Uninstall.”
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Using your printer with Macintosh computers

Printing from a software application

You can use a software application to print images stored in your computer’s
hard disk using the DPP-SV77 Digital Photo Printer.

Notes

• This sections explains the settings and operations using a typical application as an
example.  Depending on the application, print settings and operations may differ.  For
the details, refer to the manual of your application.

• To get the print you expect, we suggest you use software application that allows you
to check a print preview.  Otherwise, set the image size to 1664 (dots) x 2466 (dots)
and the resolution to 403 dpi.

1 Start the application software that you use to print with, and
select the image to be printed.

2 Select “Chooser” from the Apple menu, click “Sony DPP-SV77”
in the “Chooser,” and then close the “Chooser.”

3 Click “Print Setup” from the “File” menu of the application.
The “Print Setup” dialog box appears.

4 Choose the printer
settings.

Paper/Margin To make Post Card Size borderless prints, click “Post
Card” and the no margin icon .  To make border Post
Card Size print, click “Post Card” and the margin icon

. To make Small Size prints, click “Small.”

Orientation To print a wide image, click the landscape icon .
To print a tall image, click the portrait icon .

Overcoat Select the overcoat type (“Glossy”/“Texture”).

Enlarge/Reduce Select the size to be print:  enlarged or reduced.
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5 Click “OK” to close the dialog box and select “Print” from the
“File” menu.
The “Print” dialog box appears.

Print range Specify the pages to start and end printing.  To print all the
pages, select “All.”

Copies Enter the number of copies to be printed.

Preview Displays a print preview.

6 Set the print range and copies and click “Print.”
The printer starts printing.  To stop printing, click “Cancel.”
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Additional information

Precautions

On safety
• Operate the printer on 120 V AC, 60

Hz (for the 110 to 120V area) or 220
to 240 V AC, 50/60 Hz (for the
models for other areas) only.

• Be careful not to set or drop any
heavy objects on the power cord, or
to damage the power cord in any
way. Never operate this printer with
a damaged power cord.

• Should any solid object or liquid fall
into the cabinet, unplug the printer
and have it checked by qualified
personnel before operating it any
further.

• Never disassemble the printer.
• To disconnect the power cord, pull it

out by the plug. Never pull the
power cord itself.

• When the printer is not going to be
used for an extended period of time,
disconnect the power cord from the
wall outlet.

• Do not handle the printer roughly.
• To reduce the risk of electrical shock,

always unplug the printer from the
electrical outlet before cleaning and
servicing the printer.

• Take care not to scratch or damage
your printer’s LCD screen. Always
use the supplied stylus or a plastic-
tipped pointer to tap on the screen.
Do not use a real pen, pencil, or
other sharp object on the screen.

• Your printer’s screen is made of
glass. Do not drop or submit your
printer to external shock.

On installation
• Avoid placing the printer in a

location subject to:

– vibration
– high humidity
– excessive dust
– direct sunlight
– extremely high or low
temperatures

• Do not use electrical equipment near
the printer. The printer will not work
properly in electromagnetic fields.

• The printer is designed to operate
horizontally. Never attempt to
operate the printer in a tilted
position.

• Do not place heavy objects on the
printer.

• Leave enough room around the
printer so that the ventilation holes
are not blocked. Blocking these holes
may cause internal heat build-up.

On moisture condensation
If the printer is brought directly from a
cold location to a warm location or
placed in an extremely warm or humid
room, moisture may condense inside the
unit. In such cases the printer will
probably not work properly and may
even develop a fault if you persist in
using it. If moisture condensation
occurs, turn off the power and do not
use the printer for at least one hour.
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On transport
When you transport the printer, remove
the print cartridge, paper tray, the
“Memory Stick” or PC card from the
printer and put the printer and its
peripherals in the original box with the
protective packaging.
If you no longer have the original box
and packing parts, use similar packing
material so that the printer will not be
damaged while being transported.

On cleaning
Clean the cabinet, panel and controls
with a soft dry cloth, or a soft cloth
lightly moistened with a mild detergent
solution. Do not use any type of solvent,
such as alcohol or benzine, which may
damage the finish.
On cleaning of the LCD display, please
see page 11.

On restrictions on duplication
If duplicating documents with the
printer, pay special attention to the
following:

• Duplication of banknotes, coins, or
securities is against the law.

• Duplication of blank certificates,
licenses, passports, private securities,
or unused postal stamps is also
against the law.

• TV program, films, video tapes,
others’ portraits or other materials
may be copyrighted.  Unauthorized
video printing of such materials may
infringe the provisions of the
copyright law.
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LOCK LOCK

About the “Memory Stick” and PC card media

The printer can read and write “Memory
Stick” and PC card (PCMCIA ATA
compatible type II flash memory cards
with a power specification of 5V or 3.3/
5V).  By using a commercially available
PC card adaptor, you can also use Smart
Media and other types of compact flash
memory cards.

On “Memory Stick”

“Memory Stick” is a removable storage
media used with a digital still camera,
video camera, or PC.  You can easily
display, save or delete images using this
medium.
There are two types of “Memory Stick”:
an ordinary “Memory Stick” and
“MagicGate Memory Stick.”  The
“MagicGate Memory Stick” is equipped
with the MagicGate copyright protection
technology that uses encryption
technology.  You can use both types of
“Memory Stick” with your printer.
However, because the printer does not
support the MagicGate standards, data
recorded with the printer is not subject
to MagicGate copyright protection.

To protect “Memory Stick”
images

To prevent accidental erasure of
important image data, use the write
protect switch on the “Memory Stick.”
Slide the switch to the write protect or
write enable position:

xWrite enable position

Slide the switch left to the write
enable position.  You can read, write
and delete data on the “Memory
Stick.”  Formatting the “Memory
Stick” is also enabled.  When storing
images on the “Memory Stick,” set
the switch to the write enable
position.

xWrite protect position
Slide the switch right to the write
protect position.  It is now
impossible to write or delete the data
on the “Memory Stick.”  We suggest
you set the switch to the write
protect position while just viewing
“Memory Stick” images.

Write
protect
position

Write
enable
position

Connector

Place the label here
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Notes on use

• You cannot use PC cards with a
power specification of 3V only.

• Do not insert other types of PC card
into the printer’s insertion slot.  The
printer may be damaged.

• Do not drop, bend, or submit the
“Memory Stick” or PC card to
external shock.

• Do not disassemble or modify the
“Memory Stick” or PC card.

• Avoid getting liquids on the
“Memory Stick” or PC card or using
them in areas subject to high
humidity.  Otherwise, data may be
rendered unreadable.

• Avoid using or storing the “Memory
Stick” or PC card in a location
subject to:
– extremely high temperature such as

the hot inside of a car or the
outdoors exposed to a direct
sunlight, or a place near a heater.

– direct sunlight

– high humidity

– corrosive substances

– excessive dust

– electrostatic or electronic noises

– magnetic fields

• Avoid touching the connector of the
“Memory Stick” or contacting it with
a metal object.

• When attaching a label to the
“Memory Stick” as specified in the
illustration, use the label supplied
for the “Memory Stick” only.  Do not
use any other labels.

• When storing and carrying the
“Memory Stick” or PC card, keep it
in its original case to ensure
protection of important data.

• Avoid removing the “Memory Stick”
or PC card from the insertion slot or
turning off the power of the printer
while the printer is accessing the
“Memory Stick” or PC card.
Otherwise, data may be rendered
unreadable.

• When using a compact flash card or
Smart Media, use a commercially
available PC card adaptor that is
compatible with the card.   Insert the
card into the adaptor and then insert
it into the printer.  For how to install
the card and adaptor, refer to the
operating instructions of the PC card
adaptor.

• Avoid inserting or removing the
compact flash card or Smart Media
into or out of the PC card adaptor
while the PC card adaptor is inserted
in the printer.  The data may be
rendered unreadable or erased.
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If you run into any problems using the
printer, use the following guidelines to
solve the problem. If the problem
persists, consult your Sony dealer.
When you are printing from your
computer, also refer to the computer
manual.

Cannot operate the printer after the
power switch is turned on.

m Connect the AC power cord to an
AC outlet securely.

The LCD screen of the printer
displays no images.

m Insert a “Memory Stick” or PC card
securely. Check that images
recorded by a digital still camera or
other device are recorded.

m Make sure that the PC input
indicator is not lit.

m Tap [INPUT SELECT] to turn on the
“MEMORY STICK” or PC CARD
indicator.

The television displays no images.
m Set the input selector of the

television to “VIDEO.”

m Connect the printer to the television
properly and turn both on.

m Make sure that Video Output is set
to On in the Screen Setup of the
Menu screen.

Cannot print.
m Insert the correct set of print

cartridge and print paper.

m Check that the paper tray has paper.

m The thermal head may be
overheated.  Leave the printer until
the head cools down and the printer
resumes printing.

m Remove the jammed paper, if any.

An image in thumbnail list is not
properly displayed or printed.

m If the image is displayed but can not
be printed, the file used for printing
is damaged.

m If the mark shown on
the right is displayed
in the thumbnail list,
the image is a JPEG
file created with your
computer, or the
thumbnail data of the
image is damaged.

Select the mark and press PICTURE.
If a preview image is displayed, you
can print the image. If the same
mark is displayed again as a
preview, the image is stored in an
incompatible file format that the
DPP-SV77 does not support or the
image itself is damaged.

Troubleshooting
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m An image which is damaged or has
some kind of problem will not
appear in the image list.  A file error
message appears on the display.  If
there are no images stored in the
“Memory Stick” or PC card, the no
file message appears on the display.

m If an image is not compatible with
DCF (Design rule for Camera File
system), it may not be printed using
the printer even if it is displayed on
the PC monitor.

m The printer can handle and display
up to 999 image files.  If there are
more than 999 images stored in the
“Memory Stick” or PC card, use the
computer to display and handle the
remaining images.

m Depending on the type of digital
still camera used, the aspect ratio of
the recorded image differs, so the
image may not be printed covering
the entire printable area.

m Depending on the type of digital
still camera used, preview images
may be displayed along with the
primary images in the thumbnail
list.  The printed quality of the
preview images will not be as good
as the primary images.  Note that if
you delete the preview images, the
data for the primary images may be
damaged.

m Depending on the type of digital
still camera used, the image may be
stretched vertically if it has been
rotated or processed using your
digital still camera. This is not
because of trouble with the printer,
but because the image was rewritten
using your digital still camera.

m Some types of PC card adaptor that
are not compatible with PCMCIA
ATA cannot be used with this
printer.

The beeps sound.
m Check that you are following the

correct procedures.

Cannot remove the print cartridge.
m Turn the printer off then on.  After

the motor sound stops, try to
remove the cartridge.

The or  indicator is lit or an
error message is displayed.

m Follow the instructions on the
screen.
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Troubleshooting

If paper jams

If the print paper jams, the paper error indicator lights and an error
message is displayed.  Printing stops. Turn the printer off and remove the
jammed paper from the paper outlet or take out the paper tray to remove the
jammed paper.

Note

If you cannot remove the jammed paper, contact your Sony dealer.

Pull out the jammed paper
slowly.

Take out the paper tray
to remove the jammed
paper.
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Specifications

Printing system

Sublimation dye transfer printing
(Yellow/Magenta/Cyan 3 pass)

Resolution

403 (H) x 403 (V) dpi

Gradations

256 levels (8 bits for each Yellow/
Magenta/Cyan), approx. 16,770,000
colors

Printing size

152.4 (H) x 101.6 (V) mm (maximum,
Post Card Size, borderless) (6 x 4 inches)

Printing time

Approx. 90 seconds per sheet (Post Card
Size Paper)

Approx. 60 seconds per sheet (Small Size
Paper)

(excluding the time for data processing
and data transferring from the personal
computer or “Memory Stick” or PC card)

Input/output connectors

USB connector (1)

VIDEO OUTPUT connector (phono jack
x 1)

1 Vp-p, 75 ohms (unbalanced),
sync negative

Slot

“Memory Stick” insertion slot (1)
PC card insertion slot (PCMCIA II) (1)

Compatible image file formats

JPEG: 4:4:4, 4:2:2, 4:2:0 (baseline JPEG)

BMP:  24 bits full color, Windows format

(Note that some versions of the file
formats may not be compatible.)

Maximum number of files to be handled

999 files

Print cartridge/Print Paper

See “Preparing the printing pack” on
page 18.

LCD display

3.2 inch transparent STN color display

960 x 240 dots

Power requirements

120 V AC, 60 Hz, 1.16 A
(for 100 to 120 V users)

220 - 240 V AC, 50/60 Hz, 0.62A
(for 220 to 240 V users)

Power consumption (standby mode)

Approximately 1 W

Operating temperature

5 ˚C to 35 ˚C (41 ˚F to 95 ˚F)

Dimensions

Approx. 242 x 87 x 267 mm
(w/h/d, excluding protruding parts)

(9 5/8  x 3 1/2 x 10 5/8 inches)

(363 mm (14 3/8 inches) of depth when
the paper tray is installed.)

Mass

Approx. 2.4 kg (5 lb 5 oz)

(excluding the 0.1 kg (4 oz) paper tray)

Supplied accessories

See “Unpacking the printer” on page 7.

Design and specifications are subject to
change without notice.
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